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Slide 1 

Slide notes: Project Length: 8:34 

Slide Length: 8.8s 

 

Hello everyone, in this demo you will see how to use IBM Informix Dynamic Server with Visual Studio 2005. 
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Slide 2 

Slide notes: Slide Length: 33.5s 

 

This demo has been tested from a user account with administrator privileges on Windows XP. You should also have Visual Studio 2005 installed and 
the Informix Client-SDK with the Visual Studio Add-Ins. See Part 1 of this demo series for how to do this. There are also two articles on IBM 
developerWorks that describe in greater depth some of the capabilities of the IBM Visual Studio Add-Ins. In future demos we will describe some of the 
more advanced features of the IBM Add-Ins. 
 
Text Captions: Click Links to Visit Web Pages 
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Slide 3 

Slide notes: Slide Length: 4.5s 

 
Let's begin by creating a database connection. 
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Slide 4 

Slide notes: Slide Length: 6s 

 
Launch Visual Studio 2005 and select the Server Explorer. 
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Slide 5 

Slide notes: Slide Length: 4s 

 
Select Data Connections. 
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Slide notes: Slide Length: 3s 

 
Right-click. 
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Slide 7 

Slide notes: Slide Length: 4s 

 
Select Add Connection... 
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Slide 8 

Slide notes: Slide Length: 5s 

 
Select IBM Informix in Data source. 
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Slide 9 

Slide notes: Slide Length: 5.5s 

 
Deselect the Always use this selection check box. 
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Slide 10 

Slide notes: Slide Length: 3s 

 
Click Continue. 
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Slide 11 

Slide notes: Slide Length: 3.5s 

 
Enter your server name. 
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Slide notes: Slide Length: 7s 

 
 

 

 

 



��������	
 ���
���
��������
���
���� 


 

����
��
��
���


 

Slide 13 

Slide notes: Slide Length: 9.5s 

 
Enter your user id and password. You can use the user informix and the password you created for this user when you installed the software. 
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Slide 14 

Slide notes: Slide Length: 5.5s 
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Slide 15 

Slide notes: Slide Length: 4.3s 

 
Enter stores_demo as the database name. 
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Slide 16 

Slide notes: Slide Length: 4.3s 

 
Click the Test Connection button. 
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Slide 17 

Slide notes: Slide Length: 3.5s 

 
The connection should succeed. 
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Slide 18 

Slide notes: Slide Length: 3s 

 
Click OK. 
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Slide 19 

Slide notes: Slide Length: 4.3s 

 
You can check the filtering options. 
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Slide 20 

Slide notes: Slide Length: 2s 
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Slide 21 

Slide notes: Slide Length: 1.5s 
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Slide 22 

Slide notes: Slide Length: 6s 

 
Here Tables, Views, Procedures and Functions have been pre-selected. 

 

 

 



��������	
 ���
���
��������
���
���� 


 

����
��
��
���


 

Slide 23 

Slide notes: Slide Length: 0.7s 
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Slide 24 

Slide notes: Slide Length: 1.6s 
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Slide notes: Slide Length: 0.5s 
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Slide 26 

Slide notes: Slide Length: 3s 

 
Click OK. 
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Slide 27 

Slide notes: Slide Length: 6.4s 

 
The Informix connection will appear under Data Connections. Expand the tree. 
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Slide 28 

Slide notes: Slide Length: 4s 

 
Expand the tree under Tables. 
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Slide notes: Slide Length: 4s 

 
Expand the tree under the customer table. 
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Slide 30 

Slide notes: Slide Length: 4s 

 
Select the fname column. 
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Slide notes: Slide Length: 3s 

 
Right-click. 
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Slide 32 

Slide notes: Slide Length: 4s 

 
Select the Properties menu item. 
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Slide 33 

Slide notes: Slide Length: 4s 

 
Double-click the Properties title bar. 
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Slide 34 

Slide notes: Slide Length: 5.7s 

 
The Properties window gives us some information, such as the type of the column. 
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Slide 35 

Slide notes: Slide Length: 3s 

 
Close the window. 
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Slide notes: Slide Length: 4.6s 

 
Next, let's create a simple Windows application. 
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Slide 37 

Slide notes: Slide Length: 3s 

 
Select the File menu. 
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Slide 38 

Slide notes: Slide Length: 3s 

 
Select New. 
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Slide notes: Slide Length: 3s 

 
Select Project... 
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Slide 40 

Slide notes: Slide Length: 4s 

 
Let's close the tree under Visual Basic. 
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Slide 41 

Slide notes: Slide Length: 3s 

 
Select Visual C#. 
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Slide notes: Slide Length: 3s 

 
Select Windows. 
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Slide 43 

Slide notes: Slide Length: 4s 

 
Select the Name text box. 
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Slide 44 

Slide notes: Slide Length: 5s 

 
Enter a name, such as customerApp. 
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Slide 45 

Slide notes: Slide Length: 3s 

 
Click OK. 
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Slide 46 

Slide notes: Slide Length: 4.3s 

 
If a Properties window opens, close it. 
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Slide 47 

Slide notes: Slide Length: 5.6s 

 
Ensure that the form is open in design mode and select the Data menu. 
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Slide 48 

Slide notes: Slide Length: 4s 

 
Select the Add New Data Source... menu item. 
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Slide 49 

Slide notes: Slide Length: 4.8s 

 
Ensure that Database is selected and click Next. 
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Slide 50 

Slide notes: Slide Length: 6.3s 

 
I will choose to include sensitive data in the connection string to show you all the data. 
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Slide 51 

Slide notes: Slide Length: 4.3s 

 
Click the Connection string button. 
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Slide 52 

Slide notes: Slide Length: 3s 

 
Click Next. 
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Slide 53 

Slide notes: Slide Length: 5.2s 

 
Choose to save the connection string information and click Next. 

 

 

 



��������	
 ���
���
��������
���
���� 


 

����
�	
��
���


 

Slide 54 

Slide notes: Slide Length: 2s 
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Slide 55 

Slide notes: Slide Length: 3s 

 
Expand the tree under Tables. 
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Slide 56 

Slide notes: Slide Length: 4s 

 
Expand the tree under customer. 
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Slide 57 

Slide notes: Slide Length: 4s 

 
Check the customer table to select all the columns. 
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Slide 58 

Slide notes: Slide Length: 3s 

 
Click Finish. 
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Slide 59 

Slide notes: Slide Length: 4s 

 
Select the Data menu again. 
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Slide 60 

Slide notes: Slide Length: 4s 

 
Select Show Data Sources. 
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Slide 61 

Slide notes: Slide Length: 5.5s 

 
In the Data Sources window expand the tree under customer. 
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Slide 62 

Slide notes: Slide Length: 5.7s 

 
With the customer table selected, drag and drop it onto the form. 
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Slide 63 

Slide notes: Slide Length: 3.3s 
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Slide 64 

Slide notes: Slide Length: 3.5s 

 
Close Data Sources. 
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Slide 65 

Slide notes: Slide Length: 4s 

 
We can run this application immediately. 
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Slide notes: Slide Length: 4s 

 
Hold down the Ctrl key and press F5. 
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Slide 67 

Slide notes: Slide Length: 5.5s 

 
The application will start running. You can maximize the window if you wish. 
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Slide notes: Slide Length: 1.6s 
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Slide notes: Slide Length: 3.4s 
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Slide notes: Slide Length: 1.6s 
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Slide notes: Slide Length: 1.1s 
 

 

 

 



��������	
 ���
���
��������
���
���� 


 

����
��
��
���


 

Slide 72 

Slide notes: Slide Length: 7.8s 

 
Various buttons are available to scroll through the data, add a new row, delete a row and save any changes. 
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Slide notes: Slide Length: 1.6s 
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Slide notes: Slide Length: 1.6s 
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Slide notes: Slide Length: 1.6s 
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Slide 76 

Slide notes: Slide Length: 3s 
 
Text Captions: Click the Move first button 
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Slide 77 

Slide notes: Slide Length: 3.7s 
 
Text Captions: Click the Restore button 
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Slide 78 

Slide notes: Slide Length: 4.4s 

 
Close the window to stop the application. 
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Slide 79 

Slide notes: Slide Length: 3s 

 
Close the Output window. 
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Slide 80 

Slide notes: Slide Length: 2s 
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Slide 81 

Slide notes: Slide Length: 4s 

 
Finally, let's create a simple web page. 
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Slide 82 

Slide notes: Slide Length: 3s 

 
Select the File menu. 
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Slide 83 

Slide notes: Slide Length: 3s 

 
Select New. 
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Slide 84 

Slide notes: Slide Length: 3s 

 
Select Web Site... 

 

 

 



��������	
 ���
���
��������
���
���� 


 

����
 �
��
���


 

Slide 85 

Slide notes: Slide Length: 4s 

 
Ensure that ASP.NET Web Site is selected. 
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Slide 86 

Slide notes: Slide Length: 3s 

 
Click OK. 
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Slide 87 

Slide notes: Slide Length: 4s 

 
Select the Design tab. 
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Slide 88 

Slide notes: Slide Length: 3s 

 
Select the Toolbox tab. 
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Slide 89 

Slide notes: Slide Length: 4s 

 
Close the tree under Standard. 
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Slide notes: Slide Length: 4s 

 
Expand the tree under Data. 
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Slide 91 

Slide notes: Slide Length: 3.2s 

 
Drag and drop this onto the Design window. 
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Slide notes: Slide Length: 3.2s 

 
Drag and drop this onto the Design window. 
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Slide notes: Slide Length: 4s 

 
Select Configure Data Source... 
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Slide notes: Slide Length: 3s 
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Slide notes: Slide Length: 4.3s 

 
From the combo box, select stores_demo. 
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Slide notes: Slide Length: 1.6s 
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Slide 97 

Slide notes: Slide Length: 4s 

 
Click the Connection string details button. 
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Slide notes: Slide Length: 3s 

 
Click Next. 
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Slide notes: Slide Length: 3s 

 
Click Next. 
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Slide 100 

Slide notes: Slide Length: 7s 

 
Select the Specify a custom SQL statement or stored procedure radio button. 
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Slide notes: Slide Length: 3s 

 
Click Next. 
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Slide notes: Slide Length: 3s 
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Slide 103 

Slide notes: Slide Length: 11s 

 
Type the text shown in the text box. Replace db2admin with your schema name. 
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Slide notes: Slide Length: 3s 

 
Click Next. 
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Slide notes: Slide Length: 3.5s 

 
Click Test Query. 
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Slide notes: Slide Length: 3s 

 
Click Finish. 
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Slide notes: Slide Length: 3s 

 
Select the Toolbox tab again. 
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Slide notes: Slide Length: 3.5s 

 
Select DetailsView. 
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Slide notes: Slide Length: 1.6s 
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Slide notes: Slide Length: 3.5s 

 
Drag and drop this onto the Design window. 
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Slide notes: Slide Length: 3.5s 

 
Select the combo box. 
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Slide notes: Slide Length: 4s 

 
Select SqlDataSource1. 
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Slide notes: Slide Length: 4.3s 

 
Select the Enable Paging check box. 
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Slide 114 

Slide notes: Slide Length: 4s 

 
Select the AutoFormat... link. 
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Slide notes: Slide Length: 4s 

 
Select a scheme, such as Colorful. 
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Slide 116 

Slide notes: Slide Length: 3.5s 

 
Apply the scheme. 
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Slide 117 

Slide notes: Slide Length: 3s 

 
Click OK. 
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Slide 118 

Slide notes: Slide Length: 2s 
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Slide 119 

Slide notes: Slide Length: 3s 

 
Select the DetailsView. 
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Slide 120 

Slide notes: Slide Length: 3s 

 
Expand the table. 
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Slide 121 

Slide notes: Slide Length: 1.9s 
 

 

 

 



��������	
 ���
���
��������
���
���� 


 

����
���
��
���


 

Slide 122 

Slide notes: Slide Length: 4s 

 
Hold down the Ctrl key and press F5. 
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Slide 123 

Slide notes: Slide Length: 1.6s 
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Slide 124 

Slide notes: Slide Length: 5.5s 

 
A web browser window should open. Maximize it if necessary. 
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Slide 125 

Slide notes: Slide Length: 4s 

 
Scroll through the results. 
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Slide 126 

Slide notes: Slide Length: 1.6s 
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Slide notes: Slide Length: 3s 
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Slide 128 

Slide notes: Slide Length: 3.5s 

 
Close the window. 
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Slide 129 

Slide notes: Slide Length: 3.5s 

 
Close the Output window.  

 


